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Abstract—The web teaching platform based on virtual reali-
ty technique is a challenge to the traditional teaching mode 
and a necessity with the development and maturity of in-
formation technologies. Based on the easily made and oper-
ated VR techniques with its immersion and interactivity, 
this paper combined resources about the enginery 
knowledge and information to build the overall platform. It 
significantly improves users’ feeling about and understand-
ing of the part models. It can be visually perceived and is 
flexible and convenient, providing users with operating 
experience which makes virtual reality and the real world 
consistent with each other. Eventually, both people and 
models can dynamically interact and perceptively communi-
cate with each other. 

Index Terms—enginery teaching platform; computer dy-
namic simulation technique; electronic file. 

I. INTRODUCTION 
Virtual reality is a digital information technique devel-

oped over a long period of time by labs of various disci-
plines. The rapid development of various techniques, 
including screen, computer system, graphics, optical fiber 
and 3-D tracing also boosted the development of virtual 
reality. When various techniques reached their corre-
sponding highest standards, the virtual reality technique 
based on these techniques appeared naturally. It can create 
the virtual world, or help to experience the virtual world. 
It is called “Ling Jing” or “Huan Zhen” in Chinese [4]. 
The so-called virtual reality is a lifelike virtual world 
created by computer graphics and possessing visual, audi-
tory and tactile senses. The virtual reality technique covers 
knowledge of various branches of information, such as AI, 
image processing, intelligent interface, sensor technique, 
multi-thread processing and network. It can be utilized in 
other disciplines, such as mathematics, physics and geog-
raphy. 

The virtual reality technique provides users with some 
advanced interfacing methods. The advanced sensor de-
vices can be employed to observe and operate in 360 de-
grees the object models in a virtual setting in order to 
naturally interact with virtual setting and to provide users 
with a direct and natural visiting experience. Generally, a 
typical virtual reality system comprises a computer, input 
device, output device, virtual reality software, as well as a 
virtual world [1]. Meanwhile, it boasts three important 
characteristics; namely, immersion, interactivity and im-
agination. 

II. METHODS FOR VIRTUAL REALITY TECHNIQUE 
The virtual reality technique is based on advanced de-

vices, such as a data helmet and a glove. However, with 
the developing of information technologies over many 
years, the virtual reality technique has evolved into includ-
ing all and any related techniques and methods possessing 
virtual reality and lifelike experience. Depending on vary-
ing degree of interactivity and immersion, a virtual reality 
system can be categorized into four types: 

(1) Desktop VR  
The desktop VR system is the VR environment system 

based on a computer and a workstation. The computer 
screen is used by users as the transmission medium be-
tween the virtual world and the real world to experience 
the object models in the virtual environment. Meanwhile, 
the input devices are equipped to work this virtual envi-
ronment and to operate models in the virtual setting so that 
the object models can be rotated, zoomed out and browsed 
in 360 degrees in the virtual environment. Due to its rela-
tively low costs, the desktop virtual reality system is more 
likely to be popular. A personal computer and some relat-
ed input and output devices are what is needed to create a 
three-dimensional space to build up the feelings of immer-
sion. 

(2) Immersive VR System  
The immersive VR system is capable of creating a new 

virtual space for any experiencers. With advanced virtual 
reality devices, the user’s visual, auditory and tactile sens-
es are all included in the experience, so that the user can 
be put into the virtual reality world, being part of it and 
having a sense that one is personally on the scene. In this 
way, users can avoid outside interference and concentrate 
on studying in the virtual reality environment. Immersion 
manifests itself in the degree of existing in the virtual 
space. However, it also has weaknesses [2]. For example, 
for developers, the immersive virtual reality system is 
difficult to build and more complicated. For users, a data 
glove, position sensors and other advanced devices must 
be used to interact with objects in the virtual reality envi-
ronment. However, these advanced devices are generally 
expensive, and therefore will probably not, gain wide-
spread popularity. 

(3) Superposed Virtual Reality System 
The superposed virtual reality system, also called en-

hanced virtual reality, is capable of providing a virtual 
reality system which is connected with the real environ-
ment and stored in computer. Through a wearable headset 
screen, based on the real environment, the superposed 
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computer virtual images significantly improve users’ 
experience and feelings towards virtual environment. 
Compared with other types of virtual reality techniques, 
the superposed virtual reality system can be used to en-
hance users’ perception about the realness of the virtual 
environment. Additionally, it may even enhance feelings 
that are impossible in the real world. Users can operate the 
model objects in virtual reality world at will according to 
their jobs. Meanwhile, they can obtain synchronized activ-
ity information from the produced environment [3]. 

(4) Distributed Virtual Reality System 
The distributed virtual reality system is a resource-

abundant network virtual world built by the network 
communication technologies and virtual reality tech-
niques. It provides a virtual space which can be shared 
through a network and breaks the limitation of spatial 
positions. Wherever the users are, the virtual environment 
can be accessed to do work through the network so that 
the virtual reality resources can be shared through the 
network and mutual study and communication can be 
achieved. It can also provide efficient computing capabil-
ity for the virtual reality system. For example, the long-
distance virtual lab can be accessible to users at various 
geographic locations at the same time through the network 
so that researchers can communicate and co-operate to 
finish the experiments [5]. In this way, long-distance co-
operative work can be achieved. It can also be widely used 
in various fields, such as engineering, training and enter-
tainment. 

III. BUILDING OF WEB SERVER 
A web server is computer software on the internet, 

which is also called HTTP server. After users request 
files, at first, the server will be connected. When the serv-
er receives requests for connection and processed them, 
the information is communicated to the user’s browser 
through the network. The communicated information can 
also control the methods of how the browser checks the 
information documents through codes [6].  

A web server also has a storage function, which can run 
scripts and software while users are browsing information. 
If information should be provided on the web, a request 
list is needed that asks users to input relevant information. 
After the list is filled in and submitted, it is sent to soft-
ware with particular function in the server [7]. This soft-
ware processes the request and sends a file of information 
inquiry to the reader. Software with these functions is 
called gateway scripts and software. In the web, most lists 
and search engines employ this kind of technology. 

To establish a workable web server, a well-performing 
CPU is needed as well as sufficient memory configured 
according to particular needs (e.g. 16GB or 32GB) and a 
high-capability SATA hard disk (e.g. 5TB or 8TB). A 
server of this level can be easier to maintain and manage. 
It has good performance and can serve small and medium-
size enterprises well. It can also be used in construction of 
multi-media classrooms or campus networks [10]. 

A. Development and Operation Environment 
Before using Tomcat, JDK (Java Development Kit) 

should be downloaded and installed, and the Java envi-
ronmental variables can be configured. JDK is a develop-
ing environment used to publish application, applet and 
components. It includes Java compiler, JVM, many Java 

tools and a class library based on Java and Java language 
standards. Meanwhile, any modifications of Java language 
should be included and will be published as a subsequent 
version. For a programmer, JDK is the most fundamental 
tool. 

B. Necessity of Configuring Java Environment 
Environmental variables are parameters used to desig-

nate the operating environment in the operating system. 
The PATH environmental variable is used to designate 

paths for command searching. While exercising com-
mands in Shell script, the environmental variables will 
search the corresponding command programs in the paths 
designated by the PATH variable. Thus, the Bin directory 
under the installation directory of JDK should be added to 
the existing PATH variable. Bin directory includes the 
commonly used executable files such as Java and Javadoc. 
By setting PATH variable, tools such as Javac and Java 
can be executed in any directory. 

The purpose of setting CLASSPATH is to enable the 
Java operating environment to search classes and bags 
required by Java programs which are to be executed.  

JAVA_HOME Environmental Variables. The installa-
tion locations of JDK, Eclipse, Net Beans, Tomcat and 
other software must search JAVA_HOME to determine 
the location of JDK and use it. Its functions are: (1) Con-
venient reference. For example, if JDK is installed in 
directory “C:\Program Files\Java\jdk1.7.0”, then 
JAVA_HOME should be set as this directory path. To use 
this path, only “%JAVA_HOME” should be entered, 
without having to input long path names for each refer-
ence. (2) Normalization principle. To modify the JDK 
path, only the variable value of JAVA_HOME needs to be 
altered. Otherwise, all absolute paths must be altered to 
reference documents in the JDK directory. If anyone is 
missed, some software will fail to search JDK, and as a 
result the software may crash.  

The third-party software shall reference the configured 
JAVA_HOME variables so that this software can be 
properly operated. Thus, if any software fails to run 
smoothly, JAVA_HOME may be incorrectly set.  

C. Methods for Configuring Java Environmental 
Variables 

(1) In order to configure java environmental variables, 
first choose the Advanced Settings option in the comput-
er’s Properties tab. Then go to the setting for environmen-
tal variables. 

(2) Newly establishing variable name(N): 
JAVA_HOME variable value (V): C:\Program 
Files\Java\jdk1.8.0_65, as shown in Figure 1. 

 
Figure 1.  Configuration of JAVA_HOME environment variable 

Variable Name(N): CLASSPATH 
Variable Value(V): %JAVA_HOME%\lib\dt.jar;% 

JAVA_ HOME %\ lib\ tools.jar;, as shown in Figure 2.  
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Figure 2.  Configuration of CLASSPATH environment variable 

Select the environmental variable with its variable name 
as Path in System Variables. The absolute path of the Bin 
directory in the JDK installation directory should be added 
to value of Path variable. Variable Name (N): Value of 
Variable Path (V): %JAVA_HOME%\bin; %JAVA_ 
HOME%\jre \ bin;, as shown in Figure 3. 

 
Figure 3.  Configuration of path environment variable 

Test whether the Java environment has been successful-
ly configured. Use the keyboard shortcut Win+R to start 
the Control Window of the Command Prompt and input 
“java-version”. If the version number of the Java software 
can be displayed, it suggests that the configuring process 
has been successful. Then the testing procedure is finished. 
As shown in Figure 4, the version number is “1.8.0_65”. 

 
Figure 4.  Configuration of CATALINA_HOME environment variable 

D. Configuring Web Server 
Download and install Tomcat 8.0. Then the environ-

mental variables should be configured. Variable Name: 
CATALINA_HOME. Variable Value: C:\Program 
Files\Apache Software Foundation\Tomcat 8.0, as shown 
in Figure 5. 

After the configuring of environmental variables has 
been done, it should be tested to determine whether the 
configuring process was successful. Enter the Tomcat 8.0 
software and click “Start” to start the server. Then open IE 
browser and input the local address of server; namely 
http://localhost:8080. Then an interface shown as Figure 6 
will appear, suggesting that Tomcat Web Server has been 
successfully configured.  

IV. DEVELOPMENT OF TEACHING PLATFORM WEBSITE 

A. Introduction of Dreamweaver 
Adobe Dreamweaver (usually abbreviated to DW) is a 

visual web page editor developed by an American compa-
ny called MACROMEDIA. The software can make web 
pages and manage websites. It is the first visual webpage 
developing tool especially for professional designers of 
webpages.  With  this  software,  the  designer  can  easily 

 
Figure 5.  Configuration of the web server 

 
Figure 6.  Configuration of the web server 

make dynamic webpages that go beyond the limitations 
caused by various platforms and browsers. 

Adobe Dreamweaver CC 2015 is its newest version. It 
can be used to design webpages in a visual environment 
and quickly, conveniently and efficiently finish the pro-
cess of webpage designing. Adobe Dreamweaver CC 
supports CSS editor and Auto-Complete function of 
jQuery library code. The company Macromedia was es-
tablished in 1992 and was purchased by the company 
Adobe in 2005. In December 1997, the first version of 
Dreamweaver 1.0 was launched by Macromedia. In Sep-
tember 2005, the lanch of Dreamweaver 8 marked the end 
of the Macromedia period. Dreamweaver 8 further ad-
vanced the main functions of the previous versions and 
simplified the previous working processes, making it 
easier and more convenient to operate. After Macromedia 
was purchased by Adobe in April 2007, Adobe Dream-
weaver was published. Adobe Dreamweaver CS 5 was 
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launched in April 2010. Currently, Adobe Dreamweaver 
CC 2015 is its latest version. 

The newly added functions of Dreamweaver CC in-
clude: 

(1) Quickly checking elements on the website 
The newly added “quickly checking elements” can 

check marks in the files and can produce an interactive 
HTML tree structure for both dynamic and static contents. 
Meanwhile, the structures of static contents can be directly 
altered. 

(2) New functions for editing in real-time 
The visual editing tools in Dreamweaver CC CSS helps 

to originate simple web standard program codes. It also 
allows quick use of CSS properties, such as Gradients and 
Square Shadows.  

(3) Enhanced functions for CSS designing tools 
The designing tools include enhancement of border 

controls interface�styles for copy and paste, quickly edit-
ing s text block, enhancing the working process for cus-
tom property, shortcut keys for the keyboard, specific and 
non-specific selector as well as rolling into class, etc. 

(4) Real-time insertion 
In the latest version, the panel can be inserted without 

having to switch modes. The HTML elements can be 
directly inserted into “real time checking” and the corre-
sponding changes can be overviewed immediately. 

(1) Supporting identification files and SFTP 
When the server is connected, the connection of the 

SFTP server can be verified according to identification 
keys. 

(2) Restoration and redo 
In the previous versions, when the execution step in 

CSS Design Tool Panel are to be redone, the CSS files 
must be clicked to restore or redo this step. In the process 
of redoing and restoration, Real-Time Check automatical-
ly re-arranges the files. When the edit files of original 
codes are used and the changes are restored from Real-
Time Check, the display changes and the related original 
codes from Segmentation Check becomes the focus. All 
actions are recorded in HTML files. Any manual changes 
done by CSS files can be restored from any related files. 

(1) Changes in Dreamweaver’s extended function 
Users can use Adobe Creative Cloud to check and in-

stall Dreamweaver’s extended function; namely Addition-
al Component. To find additional component through 
Adobe Creative Cloud, click on the Window tab and se-
lect “Overview Additional Components” to display the 
page of additional components. 

(2) Changes in Synchronization Setting 
The function of the synchronization setting in the latest 

version can synchronize the settings of Dreamweaver with 
Creative Cloud. Dreamweaver CC automatically checks 
whether the sync settings have been started in the previous 
version of Dreamweaver. Then settings in Creative Cloud 
can be introduced.  

(3) Improvement in Help Menu 
The Help menu has been re-arranged and re-designed 

so that users can quickly store the new functions introduc-
tion, save video, studying resources, as well as sending 
errors and lists for function requirements. 

 

 
Figure 7.  Interactive interface of gearbox virtual disassembly 

 
Figure 8.  Interactive interface of dump track lifting 

Using Adobe Dreamweaver CC, webpages can be 
quickly and efficiently done in a visual environment. 
Adobe Dreamweaver CC supports CSS editor and Auto-
Complete function of jQuery library code. The proficient 
use of shortcut keys can get twice the result with half the 
time and effort. 

B. Designing Interactive Interface 
The building of an interactive interface is to provide an 

operative platform for users. That is to obtain resources 
measuring and drawing from various means and to inte-
grate these resources. Then these resources will be orga-
nized in a logic order to efficiently and effectively share 
these resources, to provide users with systematic resource 
services and to make standards for the subsequent manag-
ing and using of resources. 

Dreamweaver CC 2015 is used to build a enginery-type 
web teaching platform based on virtual reality techniques. 
The interfaces and final designing effects are shown in 
Figures 7 and 8. 

V. CONCLUSION 
The web teaching platform based on virtual reality 

technique is a challenge to the traditional teaching mode 
and a necessity with the development and maturity of 
information technologies. Based on the easily made and 
operated VR techniques with its immersion and interactiv-
ity, this paper combined resources about the enginery 
knowledge and information to build the overall platform. 
It significantly improves users’ feeling abour and under-
standing of the part models. It can be visually perceived, 
and is flexible and convenient, providing users with oper-
ating experience which make virtual reality and the real 
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world consistent with each other. Eventually, both people 
and models can dynamically interact and perceptively 
communicate with each other. This paper focuses on the 
following aspects: 

(1) The methods of establishing web virtual platform, 
operating principles of X3D virtual reality techniques, 
development environment and key development nodes are 
compared and analyzed to determine the key technologies 
of X3D virtual reality and an overall plan for the web 
teaching platform established by this paper.  

(2) According to requirements based on X3D virtual 
process, parametric modelling and stimulated configuring 
were conducted upon the parts. UG draft module was used 
to determine the detailed tracks of movement of parts. 
CATIA was employed to set and optimize the object 
models and generate the VRML files which can be recog-
nized by X3D language. Thus, the moving parts straying 
away from their correct tracks can be prevented. The start-
ing and ending time, the detailed tracks of movement and 
rotation angles of each object in the movement mecha-
nism can be reasonably configured. 

(3) X3D node design and its operating principles were 
analyzed. Specific cases such as the virtual disassembling 
and assembling of a decelerator in the enginery course 
module and the lifting mechanism of a dump truck in the 
innovation and practice module were used to design X3D 
source programs for virtual disassembling and assembling 
and movement simulation.  

(4) By simulating the mechanical structural movement 
and analyzing principles of animated smart sensor nodes 
of X3D virtual reality programming language, the trans-
formation formulas for X3D programming time of parts 
movement were deducted. Based on the movement prop-
erties of parts of an existing mechanism, this formula can 
directly generate the key values of parts in the time sensor 
of X3D source program. It can provide theoretical evi-
dences for X3D programming language to configure the 
assembling and disassembling of mechanical structures 
and the movement simulation through animated smart 
sensor nodes.  

(5) The functional module of web virtual teaching was 
researched and analyzed. The teaching resources about 
enginery were combined to establish the workable web 
server and to establish the overall framework for the func-
tional module in the VR web teaching platform. Through 
Dreamweaver, the integrated enginery course resources 
were uploaded into the web server. The relevant testing 
and running were conducted. Therefore, the VR environ-
ment, dynamic interaction and smart perception were 
achieved. 
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